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Overview:
The REMSpC Spray Analysis Tool (REMSAT) program has been designed to work with ESRI
GIS data, aerial and satellite imagery and AG-NAV spray files. The aim of the program is to manipulate
and plot these data in an easy-to-use and convenient format that can be used both in the field and in followup analyses. Though still in its mid-development stage, the program is currently useful as:
•

a geo-referencing tool for aerial or satellite photos

•

a digitizing tool for AG-NAV blocks, guidance lines and exclusion zones

•

a method of displaying AG-NAV spray data in relation to ground/topographical features

•

a statistical analysis and report package for operational spray programs

Future revisions include real-time data reception from spray aircraft and the integration of meteorological
data with real-time optimization of aircraft guidance .

Typical view of GIS and AG-NAV data plotted using REMSAT. Spray rate is
colour-coded along spray lines.
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Getting Started:
Installation:
1.

If the installation splash screen doesn’t automatically appear when you insert the REMSAT CD,
run REMSAT_Install.exe, located in the CD’s root directory. A splash screen will appear,
allowing the installation of REMSAT or viewing of these instructions. Click on Install
REMSAT.

2.

Any open programs should be closed prior to installation. Acceptance of the Terms of the
Licensing Agreement and Disclaimer is required to continue installation. Choose a directory for
the REMSAT installation. C:\Program Files\REMSAT is the default location. Click on the
REMSpC logo to continue. Finally, ownership information is required to track registration
information, i.e. to produce a registration key. Click OK to finish the installation.

3.

If another program is already associated with .rjm file types (ie. when you double-click a .rjm file,
Windows opens it in that program), the installation process will inform you. REMSAT uses the
.rjm extension for its session files but will not associate itself with these files if another program
already has.

4.

The REMSAT demo files will be automatically copied to C:\REMSAT Demo Files during
installation. These files are the only files REMSAT will open while in demo mode.
Please Note: The two demo ‘session’ files will try to open files from ‘C:\REMSAT Demo Files\’.
If you move the demo files to a folder other than this, you will still be able to open them
individually, however the sessions will not load properly. It is suggested that you leave the demo
files in the folder indicated above.

5.

REMSAT was designed using a resolution of 1152×864. Although every attempt has been made
to accommodate 800×600 (since most notebooks currently operate at 800×600), there may be
some minor alignment problems that have been overlooked. Please document any problems using
REMSAT and forward to REMSAT@REMSpC.com .
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Program Controls:
File:
Load Session*

Allows a session (*.rjm) file to be opened. Sessions retain loaded files and various
settings from a previous REMSAT run.

Save Session

Allows a session to be saved for later retrieval.

Load Graphic*

Opens an image file (.BMP, .TIF, .GIF, .JPG) for display.

Load GIS Layer

Opens an ESRI shape file (*.shp) or Arc Interchange file (*.e00) for display.

Load AG-NAV:
Block Boundary*

Opens an AG-NAV boundary file (*.no1) and adds it to the files list.

Guidance File

Opens an AG-NAV guidance file (*.xyz).

Exclusion Zones

Opens an AG-NAV exclusion zone file (*.xcl).

Spray Data*

Opens an AG-NAV spray session file.

Close All Files

Closes all open files and clears the graph area.

Exit

Exits REMSAT.

View:
Cluttered Mode

The default view when starting REMSAT. Displays a square graph area and
information along the right-hand side of the screen. Used when working with data
and files.

Map Mode

Expands the graph area to fill the screen. Used for greater detail of graphical data.

Preferences

Opens a small form to customize the REMSAT environment.

About

Displays information about the program.

Refresh

Performs a full redraw of all data in REMSAT’s main window.

Tools:
Spray Statistics

Opens a graphics page to display statistics for selected AG-NAV flight files.

Geo-referencing

Opens a form allowing geo-referencing of an image using selected GIS data or
manual input of coordinate locations (if no GIS files are selected).

Digitize AG-NAV
Block Boundary*

Used to create an AG-NAV block boundary.

Guidance Lines*

Used to create aircraft guidance lines within a loaded block boundary.

Exclusion Zone*

Used to create an AG-NAV exclusion zone.

Ruler

Turns on a ruler function for measuring distances. Holding the Shift key while
dragging forces the line to measure vertical or horizontal distances.

REMSAT WebUpdate

Disabled for now, it will allow you to automatically update future REMSAT
versions to the newest version via the Internet.

* These commands are unavailable or are restricted
to certain files while in demo mode.
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Main REMSAT Window:

Main Window

Loaded Files Frame

These commands can be
performed from the pop-up
(right-click) menu, however
you may find it faster to do
them this way.

Map Scale Frame

StatusBar

REMSAT Manual

Displays georeferenced aerial photos and GIS and AG-NAV files. Double-clicking in
the window allows the background colour to be changed. Cursor position is displayed in
UTM or Lat/Long coordinates on the status bar at the bottom.
Loaded files are displayed along with checkboxes that allow data plotting in the graphics
window to be turned on and off. Long filenames are abbreviated but can be seen if the
mouse pointer is briefly held over the name in the list. The following commands can be
performed directly from the list:
• Right-clicking any file in the list pops up a context-sensitive menu of actions.
• Dragging an image or GIS file over another changes the order in which the files are
graphed (top to bottom).
• Double-clicking on the coloured box next to a checkbox allows the file’s graphing
colour to be changed.
• Double-clicking an AG-NAV boundary (*.no1) file in the list opens the guidance file
for that spray block (if one exists).
• <Ctrl>-right-clicking a file in the list removes that file from REMSAT.
Displays coordinates of the four sides of the graph window. Clicking the buttons will
perform various zoom functions. Zoom boundaries can also be input manually in the
text boxes.
Seen along the bottom of the screen, the two left panels indicate the position of the
mouse pointer. The next panel indicates the current coordinate system (UTM or
Lat/Long). To switch between the two, click on this button. The next panel indicates
which zone you are in (go to View à Preferences to change this, or press <Ctrl>-P).
Beside the zone is the projection datum. Finally, the right-most panel indicates the
status of loading or graphing various files.
February 7, 2002
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Context-Sensitive Menu:
Graphics File
GIS Files

AG-NAV Files

Right-clicking on a filename in the main REMSAT window will pop up a context-sensitive menu like the
one pictured above. The menu will have different options depending on what type of file you right-click.
An example of each is shown below, along with descriptions of what functions they perform:
Graphics File popup menu:
Allows the selected image to be georeferenced.
Removes the selected image from REMSAT.
Displays the selected image’s properties.
GIS File popup menu:
Reprojects the selected GIS file to another UTM zone.
Draws a buffer zone around the selected GIS file.
Changes the selected GIS file’s graph colour.
Changes the selected GIS file’s graph thickness.
Zooms the main window to the extent of the selected GIS file.
Removes the selected GIS file from REMSAT.
Displays the selected GIS file’s properties. Also allows access to colour-coding of
SHP file features based on attributes in a .dbf file. (See further down)
When GIS files are loaded (in UTM coordinates), REMSAT assumes they are in the
current zone (displayed on Status Bar). If this is not the case, the file can be
reprojected up to 2 zones away, using the current zone’s central meridian. This
option is only available while in UTM coordinates. Coordinate system conversions
(UTMàLat./LongàUTM) also use the current zone for the projection calculations.
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AG-NAV boundary file popup menu:
Loads the guidance file for the selected boundary.
Loads exclusion zones for the selected boundary.
Loads flight files for the selected boundary.
Digitizes guidance lines inside the selected boundary.
Allows digitization of an exclusion zone for the selected boundary.
Changes the selected AGNAV boundary’s graph colour.
Changes the selected AGNAV boundary’s graph thickness.
Zooms the main window to the extent of the selected boundary.
Removes the selected AGNAV boundary and associated files from REMSAT.
Displays the selected AGNAV file’s properties.

Properties Windows:

The ‘Display Name’ property is what will be shown in
the Loaded Files frame of the main window. When a file
is loaded, the default display name is its filename.

Image Properties

GIS file properties

REMSAT Manual
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Colour-Coding GIS features:
REMSAT allows you to colour-code features in a .shp file, provided an associated .dbf file exists. To
colour code features, simply click the Colours button to display the bottom half of the window shown
below. (Note: If there is no .dbf file for a particular .shp file, the Colours button will be disabled.)
Click the By Value option to display the drop-down box and table seen below. The drop-down box lists all
the fields present in the .dbf file, and the table lists each unique value associated with a particular field. The
coloured boxes will all initially be the same colour – the colour displayed for that file in the files list. By
double-clicking the coloured box next to the desired value, a different colour can be selected for all features
in that .shp file having that value.

Colours Button

Visible only when .shp file properties are displayed. Disabled if no .dbf file exists for
the selected .shp file. Click to display the Feature Colour Coding frame.

Feature Colour Coding

Select None to display all features of the selected .shp file using the same colour.
Select By Value to colour GIS features based on individual attributes.

Fields Drop-Down Box

Lists all the fields present in the .dbf file. Changing this automatically updates the
values in the Features Table.

Features Table

Lists each unique value found in the selected field (sorted alphabetically or
numerically, depending on the data). Double-clicking the coloured box next to a value
lets you set the display colour for each GIS feature with that particular attribute.
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Map Scale Frame:

The Map Scale frame allows you to zoom in and out in the main REMSAT window. The various buttons
will become active when the appropriate files have been loaded into REMSAT. The functions of the four
buttons are as follows:
Zoom Selected GIS Layers

This button will zoom in or out to the boundaries of any GIS files that
are checked (ie. turned on) in the files list. This includes SHP files
and AG-NAV boundaries. If only one file is checked, it will zoom to
the boundaries of only that file. (To zoom to one particular file
without unchecking all the others, one could instead right-click the
particular file in the files list and select Zoom Layer or Zoom
Boundary.)

Zoom Selected Images

Similar to the Zoom Selected GIS Layers button, however this button
zooms to selected image files.

Custom Zoom

When this button is clicked, a box can be drawn around features and
when the button is “unclicked”, REMSAT will zoom to that box.
Hitting <Enter> is the same as “unclicking” the button.
When this button has been clicked down, manual entry of the zoom
boundaries can be performed by entering the desired coordinates into
the text boxes.

Previous Zoom

Clicking this button will revert to the previous zoom and location.
Repeatedly clicking it alternates between the current zoom and the
previous zoom.
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Note:

View → Preferences:
GRAPHING TAB:

You can use the mouse to navigate around the preferences, or you can
<Tab> through the various options. You can also hold <Alt> while
pressing an underlined letter to go directly to that option. <Esc> will
always cancel and <Enter> will always accept. This may be more
convenient when using notebook computers without a mouse attached.

Graphing Speed

Selecting the Layer-by-Layer / Flight-by-Flight options makes REMSAT draw files to
memory then to the screen when finished. The Line-by-Line / Positional options are
slower but show the GIS layers and AG-NAV flight data on-screen as they are being
drawn.

Immediate Graph

Redraws various layers as soon as they are checked, unchecked or somehow changed
(ie. colour, buffer, etc.) in the Loaded Files frame. If not selected, a Graph button will
appear which must be clicked to redraw files.

Fill GIS polygons

If a GIS file has polygonal features and this option is checked, the polygons will be
filled using the colour associated with that file. However, this may obscure parts of any
layers that are beneath (satellite imagery, for example). Unchecking this option will
draw polygon borders only, using the associated colour.

Graph ‘boom off’ AGNAV Data

If selected, REMSAT draws black lines for aircraft position where the spray boom is off
(as seen in the image on page 4).

Colour code AG-NAV
flow rate data

If selected, REMSAT displays the ‘boom-on’ data as a ratio of the boom’s spray rate to
the desired spray rate (red = spray rate too high, blue = spray rate too low).

Graph guidance data
above/below…

Determines whether spray data is drawn overtop of guidance data (thus obscuring parts
of the guidance lines and exclusion zones), or vice versa.

Pointer Colour

Some aerial photos or GIS colours may make it difficult to see the mouse pointer.
Clicking the cross-hair changes the pointer colour.

Units

Numbers are displayed with the appropriate units (ie. meters/feet, hectares/acres, etc.).
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FILE LOCATIONS TAB:

File Locations

Default directories can be assigned for each file type used in REMSAT. If left blank,
opens a browser window to find a
C:\ is chosen automatically. Clicking on
particular folder.

Automatically Load:

These options determine whether REMSAT opens an AG-NAV boundary’s associated
guidance and / or exclusion files when the boundary is loaded.

REMSAT Manual

February 7, 2002

10

OPTIMIZATION TAB:

Spray movement away from an aircraft depends on application parameters and meteorology.
Aircraft type coupled with drop size distribution (defined by nozzle type/product) define initial
spray-cloud characteristics.

Release height and meteorology affect spray fate.

Characterizing

operational conditions allows alternate spray strategies to be assessed.
Real-time optimization is a new technique that automatically shifts aircraft guidance lines based on
real-time meteorological conditions in order to maximize in-block deposit.

However, this

functionality has yet to be implemented operationally. Contact REMSpC for further details.

Optimization Modules

Lists characterization data files to be used to display optimization options (placed in
the Optimization folder, which is in the REMSAT program folder).

Characterization Info.

Displays information about the aircraft, product, etc. that has been used to derive
the characterization data base.

Optimization Line Colour

The colour REMSAT uses to draw the optimized guidance lines in the main
window. Double-click the box to change the colour.

Optimization Line Width

The width that REMSAT uses to draw the optimized guidance lines. Drag the
slider or <Tab> to the slider and use the left or right keys to adjust.
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UTM ELLIPSOID TAB:

Reference Ellipsoids

Displays ellipsoids contained in the Ellipsoid.dat file (REMSAT program folder).

Ellipsoid Information

Displays information on the selected ellipsoid.

Zone #

Specifies the current zone (displayed on Status Bar) and hemisphere, used when
importing or working with GIS files (i.e. coordinate conversions and georeferencing). Click on the map or the buttons to adjust the zone.
Note: you should use the value displayed beside the map for final zone selection,
not the locations of the red lines on the map. These are intended only as a simple
visual reference.
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BUFFER ZONES TAB:

Buffer Width

This is the width REMSAT will use when drawing buffer zones around buffered
GIS files (see the Context-Sensitive Menu section earlier in this manual for details
on how to activate buffer zones).

Buffer Zone Colour

The colour REMSAT uses to draw the buffer zones in the main window. Doubleclick the box to change the colour.

Buffered rivers
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AG-NAV TAB:

This tab sets the default values for creation of AG-NAV spray blocks (see page 17). See AG-NAV
documentation for a description of what each value represents.
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Tools → Spray Statistics:

Histogram Window

Holding the mouse over a histogram bar pops up a box displaying that bar’s value.

Print Button

Prints a spray operation report (see below). The report is relevant to AG-NAV files
marked for display in the Main REMSAT Window.

Before printing a report, REMSAT opens a window allowing you to specify certain information relevant to
the spray:

Company / Client Info
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Tools → Geo-referencing:

Note:

Geo-referencing is currently only available while in
the UTM coordinate system.

GIS Window

Graphics Window

GIS Window

Click to add a reference point (UTM) to the list.

Graphics Window

Click equivalent reference point on the picture. Pixel position is added to list.

Selected Points Frame

Shows the symbol, UTM coordinates and pixel coordinates of selected points, plus the
error between each point and the best fit origin (using a least squares fit method).
<Ctrl>-right-clicking a point in the list or selecting Delete Point then clicking in the list
will remove the desired point. A maximum of 8 points can be used to geo-reference an
image.

Selection Buttons

Zooming in on or out of a particular area involves simply clicking a zoom button then
pointing and clicking on the desired location. The zoom factor is 2x for both zoom in
and zoom out. With Zoom Out selected, <Ctrl>-clicking on any spot within a window
will zoom out to fit the entire object.

Preview Window

Displayed when sufficient points are selected to geo-reference the image. The preview
displays the image at its true size (i.e. each pixel in the image occupies one pixel on the
screen) with the selected GIS files drawn overtop according to REMSAT’s geo-ref
calculations. In addition, the image can be stretched or shifted underneath the GIS data
to make a better fit. Move the slider bar until correct units are displayed (1m, 10m,
100m, 1km, 10km). Values can be reset to zero at any time to return to REMSAT’s
calculated geo-referencing. (Note: although the GIS data appears to be moving in the
preview, it is the image that is being shifted and stretched underneath.)
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Tools → Digitize AG-NAV:
AG-NAV Block Boundaries:
To digitize an AG-NAV boundary, another GIS, AG-NAV or geo-referenced image must be loaded. Click
Tools à Digitize AG-NAV à Block Boundary. Trace out the block boundary using the left mouse
button (click at each corner). If a mistake is made and one or more sides are to be removed, hold the
<Ctrl> key while clicking anywhere in the GIS window. To close the final side of the boundary, right-click
anywhere on the screen. To cancel block digitization at any time, simply press <Esc>. The file can then be
saved at the prompt. A form will appear asking for various parameters:

Clicking the Previous button will load the settings used when the last block was digitized. Clicking the
Defaults button has a similar effect, except that these are values that can be specified in the Preferences
(AG-NAV tab).
After saving, the files list will be updated with the new block boundary.

REMSAT Manual

February 7, 2002

17

AG-NAV Guidance Lines:
To digitize guidance lines, one or more block boundaries must be loaded. Click Tools à Digitize AGNAV à Guidance Lines, or right-click the desired block name in the files list and choose Digitize
Guidance Lines. If guidance for this file already exists (whether already loaded into REMSAT or not),
you are asked whether you want to overwrite it. The following frame will then appear in the main
REMSAT window, presenting alignment and swath width options. To edit the options, you can:
• type in the desired number (then press <Enter> to update the lines)
• press the <Page-Up> or <Page-Down> keys (increments by ±10)
• press the Up or Down keys (increments by ±1)
• click the up and down arrows next to the box (increments by ±1)
The Half-Swath Offset option positions the first guidance line half of a swath width inside the block.
(Swath width was defined when the block was created.)

Hit <Esc> at any time (or click Cancel) to cancel digitization of guidance lines.
Clicking the Save button will save the guidance file to disk and add it to the loaded files list.
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Appendix A
Getting to know REMSAT:
Below is a list of operations that can be followed to demonstrate many of the main features of REMSAT.
Although one can freely explore the program, the following sessions highlight the main features of
REMSAT. Please note that many of REMSAT’s functions have been limited or disabled in the Demo
Mode. For example, session files cannot be saved (although the two demo sessions can be loaded). As
well, only the GIS files that are included with the demo can be loaded.

A) Grand Cayman Islands: building a spray program
1.

Before running the program, find the geo-reference file Grand Cayman.ref in the REMSAT Demo
Files folder and either rename it (i.e. New.ref, etc.) or move it to the Windows Recycling Bin.
This will force you to try the geo-referencing feature of the program. (To later skip the georeferencing step, rename the file back to Grand Cayman.ref or restore it from the Recycling Bin.)

2.

The area of interest for this spray lies in UTM zone 17 (north), using the WGS84 reference
ellipsoid. Verify along the bottom of the main REMSAT window that this is the zone and
ellipsoid you are currently using. If not, these can be changed in the preferences on the UTM
Ellipsoid tab.

3.

Click on File à Load GIS Layer. Two sample shape files are included in the REMSAT Demo
Files folder for this area and will be called Roads.shp and Buildings.shp. For now, just load the
Roads file. When loaded, it will be assigned a random colour for display.

4.

Click on File à Load Graphic. Load in the Grand Cayman.jpg image file (same folder as the
Shape files). If you followed step 1 above, the filename will appear red in the list, indicating that
it is not geo-referenced.

5.

You may wish to change the colour of the roads in the display. Either double-click the coloured
box in the files list, or right-click the roads file and select Colour from the popup menu. Red is a
good colour for the roads. If the polygons are not being filled and you would prefer that they were
(or vice versa), you can change this in the preferences on the Graphing tab (Fill GIS polygons).

6.

Right-click the image name in the Loaded Files list and select Geo-reference. The georeferencing screen will appear with the roads drawn in the left window and the image in the right
window. If you skipped step 1 above, you will see three points that have already been selected.

7.

Select a point in the roads file and find its corresponding point in the image (you will likely need
to zoom in to attain any kind of accuracy). Select the point in each window, then zoom out and
select another point. Generally, the more spread out the points are, the more satisfactory the georeferencing will be (however, if you have any geometrical distortions in your image, things may
not line up very well). Some good locations to match might be:

Top of area
8.

Right side of area

Bottom of area

Once at least two points have been selected, the Preview frame will appear with a preview of how
the GIS data is lining up with the image. If satisfactory results can’t be obtained by matching
points, the image can be shifted or stretched underneath the GIS data. Experiment with these
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buttons to see whether they can improve the alignment (the shifting / stretching can always be
reset with the corresponding Reset button).
9.

Once satisfied with the alignment, clicking the Save GeoRef button will save the reference
information and return you to the main REMSAT window. To show the image, check its name in
the files list.

10. Now that the image has been georeferenced to the roads file, load the other demo shape file for
this area (Buildings.shp). Either choose File à Load GIS Layer, or press <Ctrl-S>. (Shortcut
keys are a much easier way to accomplish many tasks in REMSAT, as with many other Windows
programs.)
11. Now would be a good time to familiarize yourself with how to zoom in and out in the REMSAT
window. To zoom to a particular shape file, right-click its name in the files list and click Zoom
Layer. To zoom out to both shape files, click the Zoom Selected GIS Layers button, or to zoom
to the image, Click the Zoom Selected Imagery button (although all three files have roughly the
same boundaries).
12. To digitize a complete AG-NAV block, first zoom into a suitable area (perhaps the forested area in
the upper right corner with the small ponds). Click Tools à Digitize AG-NAV à Block
Boundary. Trace out a polygon with a series of left mouse clicks. If you make a mistake and
want to back up one or more lines, hold the <Ctrl> key and click anywhere in the image. When
finished, right-click anywhere in REMSAT’s main window and the polygon will snap closed.
You will then be prompted as to whether you would like to save the boundary or discard it. If you
click Yes, you will be prompted to enter a filename. After doing so, the boundary will show in the
loaded files list and in the main window. You may want to choose another colour for the
boundary so that it shows up better over the image.
13. Digitizing exclusion zones uses exactly the same process. Go to Tools à Digitize AG-NAV à
Exclusion Zone and trace out a polygon overtop of the large pond. If desired, you can repeat this
step for the smaller ponds in the top right corner.
14. To digitize guidance lines, click Tools à Digitize AG-NAV à Guidance Lines. A small frame
will appear, allowing you to specify a direction (in degrees or parallel to a side), and the swath
width (in meters). Clicking save will add the guidance file to the files list.
15. To further experiment with this session at a later date, load the Grand Cayman session by clicking
File à Load Session. Keep in mind that any AG-NAV blocks, guidance lines and exclusion
zones you may have created will be lost (REMSAT won’t save these in Demo Mode).
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B) Chile: a post-spray analysis
1.

If any files are open from the last session, click File à Close All. This will close any open files
and return REMSAT to its original state.

2.

Either open the Chile session, or perform the following:
•

switch to UTM zone 18 (south), with the S. American 1969 ellipsoid (in Preferences).

•

load the Usos and Rivers shape files.

•

load the two AG-NAV blocks (M9112201.no1 and M9112301.no1).

•

right-click each block name and load their guidance files (this can be performed
automatically in the future by choosing to Automatically Load the guidance lines in the
Preferences [File Locations tab]).

•

load the logged spray files for each block by either clicking File à Load AG-NAV à
Spray Data or by right-clicking the appropriate block filename and selecting Load Spray
Data.

•

change the order the shape files are graphed so that the rivers are drawn above the surface
features (REMSAT graphs from the top down).

•

change the colours and thicknesses of the shape files and blocks, as appropriate.

3.

The first thing you’re likely to notice after loading the flight data is that it is colour-coded. The
colour has been coded to the application rate, such that green represents a proper application rate,
red is too high and blue is too low. You can turn this off and just graph the spray locations all in
one colour by unchecking Colour code AG-NAV spray rate data in the Preferences (Graphing
tab).

4.

To perform a statistical analysis of the spray data, check only the AG-NAV spray files in the list
that you want to analyze, then click Tools à Spray Statistics. This opens up a form in which
you can view and/or print the Spray Time, Turn Time, Application Rates, Cross-Track Error and
DGPS quality histograms. Holding the mouse pointer over a histogram bar will display the value
of that bar.

5.

To ‘watch’ the different spray operations, make sure Graph ‘boom off’ AG-NAV data is
checked in the Preferences, and that the Graphing Speed for AG-NAV files is set to Positional
(both of these options are on the Graphing tab). At the present time, the Speed slider for graphing
AG-NAV data simply slows down or speeds up the graphing of the flight data, however it will
eventually control the “real” speed (ie. the flight track onscreen moves at the same rate as the
airplane did in real life, or 2× the real speed, 4×, etc.). I would suggest the highest setting for now
(ie. slide it to the right), as the lowest setting is quite slow.

REMSAT Manual

February 7, 2002

21

Appendix B
Waterloo County Mosquito Adulticide
Company:
Name: REMSpC Spray Consultants
Address: 12 Welsh Dr.
Ayr
Ontario, Canada
N0B 1E0
Phone: (519) 632-5006
Fax:
(519) 632-5007
Email: Bob.Mickle@REMSpC.com

Client:
Name: Tony Endres
Address: 23 Columbia St.
Waterloo
Ontario, Canada
N2G 4E9
Phone: (519) 555-5706
Fax:
(519) 555-7468
Email: tony.endres@home.net

Application:
Aircraft:
Registration:
Product:
Product Rate:
Spray Rate:

Flights:
Block
M9112301.NO1
88.15
N9112309.T4A
M9112201.NO1
311.35
N9112212.T01
N9112209.T43
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Inside

(ha)

Outside (ha)

81.17

16.17

0.00
161.71

224.74
153.91
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Application:
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Spray Time
(% vs Sec)

Turn Time
(% vs Sec)

Application Rate
(% vs %)

X-Track Error
(% vs Swath Width)

Altitude
(% vs m.a.s.l.)

REMSAT Manual

February 7, 2002

24

